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Codex Production Suite 4.1.1
Disclaimer
Codex products are continually developed to remain at the forefront of the industry, and as such the information in this 
guide is subject to change without notice. Whilst Codex endeavours to ensure that all documentation provided is correct at 
the time of writing, this document is not guaranteed to be error-free. 

Codex does not assume responsibility for issues or losses due to misinterpretation of the information in this document, 
errors in this document, or incorrect configuration or installation of the equipment described herein.

This document is issued in conjunction with the software to be used as per the conditions of the associated beta 
agreement. 

Please report any errors found in this document to support@codex.online
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1. Codex Production Suite 4.1.1
1.1 Introduction
Welcome to this guide for Codex Production Suite 4.1.1 - a software suite from Codex that combines the 
powerful task based workflow from Vault 3.0 with an extensive tool set and newly designed user interface, and 
opens it up to the Mac OS X platform, adding support for a wide range of professional camera formats.

Codex Production Suite 4.1.1 consists of Vault Platform, Vault Review, and Codex Live, and provides a 
comprehensive feature set including: 

• Support for many popular cameras - ARRI ALEXA/MINI/AMIRA, Codex Action Cam, Canon C700/C500/C300 
Mark II, Panasonic VariCam 35 and Pure, Sony F65/F55/F5, RED EPIC/WEAPON, Phantom Flex 4K and GoPro.
• View, edit and add metadata in the Library.
• Clone camera original data to local storage.
• Primary colour correction - play back, adjust and apply LUTs and CDL looks in Vault Review.
• Synchronise audio, either with timecode or manually.
• Add Quality Control (QC) notes and create PDF QC reports.
• Transcode to common deliverable formats such as ProRes, DNxHD, and H264 with LUTs, CDL, burn-ins  
 and masks.
• VFS (Virtual File System) for fast, flexible and powerful deliverables creation.
• Framings to allow customisable extraction of ‘region of interest’ from source image into deliverables.
• Archive to disk or LTFS tape with md5 verification.
• Codex Live for on-set colour grading.

1.2 Supported Hardware
Codex Production Suite 4.1.1 can be used on several hardware platforms:

• Codex S-Series.
• Codex XL-Series.
• Mac Pro running OS X 10.10, 10.11.6+, or 10.12  (recommended specification: Processor - 3.7GHz Quad 
Core Intel Xeon E5, Memory - 32GB 1866MHz DDR3 ECC, Graphics - AMD FirePro D700 6144MB).
• MacBook Pro running OS X 10.10, 10.11.6+, or 10.12 (recommended specification: Processor - 2.8GHz Intel 
Core i7, Memory - 16GB 1600MHz DDR3, Graphics - NVIDIA GeForce GT 750M 2048MB).

Codex Production Suite 4.1.1 running on Mac OS X supports the following media readers:

• Codex Capture Drive Dock (Thunderbolt).
• Codex Capture Drive 2.0 Dock (Thunderbolt).
• Codex Capture Drive Dock (USB-3).
• Codex Capture Drive Dock (SAS).
• Codex CFast 2.0 Card Reader.
• Sony AXS-CR1.
• Sony SBAC-US30.
• Sony SBAC-UT100.
• REDSTATION REDMINI 1.8”.

Any other card reader supported on Mac OS X can also be used with Codex Production Suite - the list above 
details those integrated for use directly with media expressions, which are covered in more detail later in this 
guide. For playback to an SDI monitor from Mac, the AJA Io4K and AJA T-Tap are supported.
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1.3 Installation
Please follow the install guide available with software from https://www.codex.online/software

1.4 Login
On Mac go to /Applications/Codex and open the Vault Platform software. On Vault S/XL-Series the login screen 
is presented when the system starts.  From the login screen there is no password by default so simply click 
Login.

A password can be set later to restrict access.

1.5. Licensing
A licence is required to use the Codex Production Suite software. After logging in, click the blue ring in the top 
left corner of the screen to open the Main Menu.

Click ‘Preferences’->’System’ and click ‘Request Licence’. On Mac this will open a web browser on a page 
where you can request a licence. On Vault S/XL-Series this will present a URL for the webpage where you can 
request a licence (https://codex.online/licence-request).

Codex Support will then provide the licence key and activation instructions.

2. Vault Platform

2.1. Overview of Vault Platform
To begin we will discuss the layout of Vault Platform and explain some of the terminology used.

Click the blue ring in the top left corner to open the Main Menu:

Click the blue Codex 
ring to open Main Menu

https://codex.online/production-suite-licence-request
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The following options are available:

Project - this is where Codex Production Suite is set up for your project. There are many presets provided 
within Project to make the setup process easier. The areas within Project are: 

• Setup - here you set up Production information, as well as a ‘Project root directory’ - this is a folder that you  
 regularly want to use for transcoding and archiving to, and appears in the file browser for quick access.  
 There is also a Project frame rate that should be set correctly for your project. Click the pencil (Edit) icon in  
 the lower right corner to change the settings:

• Cameras - set up details of the cameras/formats that are being used, for example ALEXA 4:3 or   
 VariCam 35. The purpose of this is that each camera can be associated with a Framing (see below) - for  
 example you may want to extract the same region of interest from all ALEXA 4:3 clips into files for editorial or  
 dailies. Optionally, camera settings may even be matched with clips based on specific metadata, such as  
 camera serial number. 
• Framings - set up Framings for both Source and Destination. A Source Framing is the ‘region of interest’  
 from the source clip that you want to be included in deliverable files. A Destination Framing controls the  
 resolution of the file to be created (scaling), and also how the source image should be fitted.
• Deliverables - set up the types of files that are required for post production. For example, a production may  
 require H264 for iPad dailies, DNxHD MXF for editorial, DPX files for visual effects work, and a RAW image  
 format for final colour grading and DI.
• Jobs - set up templates for the workflow tasks that need to be performed. For example, you may first want to  
 Clone the data from camera media. Then you may want to Generate files for editorial. Finally you may want  
 to Archive files to LTFS tape for long term storage. These different tasks can be configured separately, or in  
 combination, inside your Job templates.
• VFS - set up the VFS (Virtual File System) to provide deliverable files inside the ‘Codex VFS’ drive that   
 appears on the Mac Desktop, or in the ‘codexvfs’ network shared drive on Vault S/XL-Series. Once   
 configured the VFS provides the files ‘on-demand’ - files for loaded material are always there and ready to  
 be copied. The folder structure and naming of the files is highly configurable using the VFS.
• Library - interact with clips on the system. For example you may select clips in order to start a Job, load  
 them into Review for playback and primary grading with CDL, or check and edit metadata. You can filter  
 the clips based on metadata and/or location, and create groups of clips, to help organise your workflow.  
 There are also useful tools for creating an ALE, timecode correction, and image flip/flop.
• Storage - view details for the media that is connected to the system, including camera media and   
 connected hard drives. The location of the media, available space, and capacity are shown. For Codex  
 Capture Drives an Erase option is provided. Other devices should be reformatted using Mac Disk Utility.
• Job Queue - view the progress of jobs that are running, as well as pause and  stop jobs if required. The  
 progress bar at the top of the Production Suite software is visible from any screen, and shows details for the  
 job that is due to complete last.
• Preferences - perform operations such as installing a licence, changing the username for the software, and  
 setting up a connection to Codex Backbone.
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3. Library
The image below shows the Library with some clips highlighted and the Tools panel open:

Main Menu

List View Group View Grid Size Filter On/Off Filter Clip ToolsSelect All/None

Clips Visible/Total Number Selected Metadata

Grid View

Select Clip

Highlighted Clip
Focused Clip

Open Clips in Review

3.1 Clip Views
Use the Grid View and List View buttons to toggle between two different views of the clips. Grid View shows the 
first frame of the clip along with the clip name. If a Poster Frame has been set in Review, this will be the frame 
shown in the Library.

List View shows the clip name, roll, timecode, duration, and location of the clip. When in Grid View use the Grid 
Size slider to adjust the size of clips that are shown.

There is also a Play View button that allows for quick playback of clips within the Library:

3.2 Clip Selection
There are buttons at the top of the screen to Select All and Select None. To manually select/deselect a clip:

• In Grid View click the circle in the top left corner of the clip.
• In List View click the circle on the left of the clip name.
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When starting a job the selected clips will be used. Clips can also be highlighted or focused as shown in the 
image above. If one or more clips are highlighted/focused then these will be used for a job, provided that no 
clips are selected. If clips are selected this always takes priority over highlighted/focused clips, so in the case 
where some clips are selected and some are highlighted/focused, only the selected clips will be used for a 
job. 

The focused clip has a play icon available on the image tile. Click the play icon to open the highlighted/
focused clips in the Play View. The function of this button can alternatively be set to ‘Launch Review’ from 
‘Preferences->System->Library->Play button’.

There are keyboard shortcuts available for highlighting, focusing and selecting clips:

• To focus a clip click on the clip name/image tile.
• To highlight multiple clips, first click to focus a clip then hold Shift and click another clip or use the cursor  
 keys to move around the grid/list.
• To highlight multiple ranges of clips hold Cmd (Mac) / Ctrl (Vault S-Series) while clicking another clip, then  
 repeat the previous step.
• When clips are highlighted/focused use the Space bar to select/deselect them.

On Vault S-Series to use an external mouse/keyboard, connect the devices and press Ctrl-T.

3.3 Filter Panel
Click the Filter button to open the Filter Panel. By applying a Filter you can control the clips that are displayed 
in the Library.

The top four options (Filter On: Media, Original Media Name, Group, Audio/Video) provide drop down options 
for quick filtering.

The rest of the options in the Filter Panel require values to be input to filter on. For example if you want to filter 
for every clip that has a metadata value of 800 for Exposure Index, click the EI button and type in 800 and 
press Enter. If you apply multiple filters then only clips that match all the filters will be displayed.
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The wildcard character * can be used to filter for clips that have any value for a particular metadata field. You 
can also search using text combined with a wildcard - for example applying a filter on ‘Roll’ for A* will match for 
any clips that have Roll metadata beginning with A.

At the bottom of the Filter Panel is the option to Show Audio Only Clips, which is switched off by default. Click 
the circle next to this option to turn it on, so that any audio files that have been linked to are displayed in the 
Library.

To toggle the Filter settings on and off, use the Filter On/Off button.

3.4 Clip Panel
Click the Clip button to open the Clip Panel. The Clip Panel shows information about the focused clip.

Important metadata such as Scene, Take, Format, EI, WB, and Shutter Angle is shown, as well as clip duration 
in frames (e.g. 1423 fr) and as timecode at the Project frame rate (e.g. [00:00:59:07] / 24).

At the bottom of the Clip Panel the Clip History is shown. This has details of every job that has been performed 
on the clip.
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3.5 Metadata Panel
Click the Metadata button to open the Metadata Panel. The Metadata Panel shows metadata information about 
a clip and provides access to the Edit Metadata feature.

The metadata shown in the Metadata Panel can be changed by selecting from the drop down options: 
Filecard, SidePanel, Project. These options can be customised if required.

There is also an All view that shows all metadata stored with the selected clip(s). A summary of the Total 
Frames and duration of the highlighted/selected clips is shown at the bottom of the Metadata Panel.

Click Edit Metadata to edit the metadata for the highlighted/selected clips.
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3.6 Edit Metadata
In the Edit Metadata area there are several views that can be used. The first two tabs give drop down options, 
and default to Project (production details) and Filecard (the most commonly edited items). Click on the Project 
or Filecard tab to change the template that is used.

There is an All view that shows every metadata item stored with a clip, and a Clip Info view showing metadata 
properties of the clip that generally (but with some exceptions) cannot be edited.

The lighter coloured fields can be edited, and the darker coloured fields are read-only. The blue fields have 
preset options available from a drop-down list. 

Click in a field to start editing metadata for a clip. Use the Edit All button to make changes to every clip loaded 
in this area. When the Edit All mode is enabled, any metadata that varies between the clips is shown as 
<mixed>. Follow the prompts to Save or Discard changes as required.

To select a clip for editing click on the thumbnails shown at the top of the screen. To move through the clips 
click and drag left or right on the thumbnails. 

The Clip Info view allows the Pixel Aspect to be adjusted. This can be used for clips recorded with an 
anamorphic lens, so that the correct de-squeeze is applied.

Other options available at the bottom of the screen are:

• Load CDL - use this to apply CDL values from a .cdl file to the clips.
• Load ALE - use this to apply metadata values from an ALE file to the clips.
• Set Source Aperture - use this to apply a Source Aperture to the clips (for defining a ‘region of interest’  
 inside the source image). Once the Source Aperture is set for a clip, this can be used to determine what part  
 of the image is shown for playback and what part of the image is used when transcoding to other file formats  
 for post production. To remove a Source Aperture, select the clip(s), click Set Source Aperture, and select  
 None.
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3.7. Tools Panel
Click the Tools button to open the Tools Panel. The Tools Panel is where you can start a job such as a Clone or 
Archive of clips, along with a range of other operations in the following categories:

3.7.1 General Tools
• Vault Review - click to load the selected clips for full screen playback, prinmary CDL-based colour grading,  
 and audio syncing adjustment with an attached HDMI/DVI/SDI monitor. QC notes can be added, and a PDF  
 report produced using the ‘PDF reports (preset)’ job.
• Group From Selection - create a Group of clips that can be used for a job. For example, you  may want to  
 create a Group of everything from the same shoot day for archiving together.
• Delete Selected Clips - delete clips from Codex media, such as a Capture Drive, Capture Drive 2.0, or  
 Transfer Drive. There is a confirmation prompt that lists the clips that will be deleted, but after this there is  
 no undo option! If the Link task has been used to add clips to the Library, using the ‘Delete Selected Clips’  
 button will remove the clip from the Library but will not delete the source file.

3.7.2 Clip Tools
• TC Sync - sync clips with audio files based on timecode. This option is only available on systems without a  
 graphics card. On systems with a graphics card this option is not available, and the Audio Sync task can be  
 used to sync audio and video, followed by Vault Review to check and adjust the sync.
• Create ALE - create an ALE (Avid Log Exchange) file for the selected clips.
• Fix TC - adjust the start timecode for a clip.
• Flip - reverse the vertical orientation of the clip.
• Flop - reverse the horizontal orientation of the clip.

3.7.3 Jobs
• There are 4 slots here that can be used to start any Job on the system. These default to the first four preset  
 Jobs on the system. Click the cog icon to set which Job is assigned to which slot.
• The Other Jobs button provides access to all the Jobs on the system. For users familiar with Vault 3.0, this  
 button has replaced Task Scheduler->Manual Jobs.
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3.8 Group View 
Click on the Group View icon to see a list of groups stored on the system. One or more groups can be selected 
and then a Job can be started. Groups created manually by the user will always be shown at the top of the list, 
with the automatically created groups (for example by the ‘Audio Sync’ task) shown below this. In the Tools 
Panel the ‘Delete Selected Groups’ button will delete just the details of the selected groups, not the actual 
source clips.

Group status is shown as Online, Offline, or Partially Offline:

• Online - all clips in the group are loaded, and the group can be used for a Job.
• Offline - no clips in the group are loaded, and the group cannot be used for a Job.
• Partially Offline - only some clips in the group are loaded, and the group cannot be used for a Job.

When a task is performed on a Group, the Clip History of the clips in the Group is updated. Because this  
information is stored in the Group, deleting Groups will also delete the associated Clip History information.

3.9. Locked Clips
When a clip is being used for a Job a padlock icon may be displayed in the top left corner of the image tile. 
This means the clip is locked and metadata cannot be edited at this time:

Locked Clip icon
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4. Preset Jobs
Codex Production Suite is configured with a range of preset templates for Jobs, Cameras, Framings, and 
Deliverables. Here we will discuss how the preset Jobs can be used. For details on how to customise the 
setup, including duplicating and editing the presets, see the later Project section. 

As a reminder, to start a job go to the Library and select some clips, then open the Tools panel where you can 
start the first four preset jobs, or click Other Jobs to start any job on the system. 

The preset Jobs available are:

• Clone (preset) - copy files from camera media to attached storage, or a Transfer Drive in Vault S/XL-Series.  
 When this job is started a file browser is shown where you can pick the source and destination for the   
 Clone. To copy files from camera media, choose the media on the left side of the browser and choose  
 the destination on the right side of the browser. As each clip is cloned to the destination, the new copy will  
 show  in the Library and can then be used for other Jobs. Note that when Codex media is loaded the clips  
 will show immediately in the Library and can then be cloned to other storage. Clips on other media must  
 first be cloned before they appear in the Library, or added to the Library using the Link job (see below).
• Link To Clips (preset) - add files to the Library without making a copy of them. When this job is started  
 a file browser is shown where you can pick a source folder containing clips you want to link to the Library.  
 (This Link process happens automatically at the end of the Clone task.)
• Archive to 2 tapes (preset) - back-up the selected clips to 2 LTFS tapes on Vault S/XL-Series. When this  
 job is started a screen will appear asking for a name for the archive (e.g. ‘Day 36’, or ‘Rolls B004-B007’).
• Archive to 2 disks (preset) - back-up the selected clips to 2 disk locations. When this job is started a  
 screen will appear asking for a name for the archive (e.g. ‘Day 36’, or ‘Rolls B004-B007’), the names of  
 the disks being used (e.g. ‘Backup Disk 1’ and ‘Backup Disk 2’), and also the destination to use for each  
 backup. Click the ‘...’ button to open a file browser and set each back-up destination.
• Media Check (preset) - get a summary of the selected media (number of clips, frames, clip format). Also  
 this job can be used to Apply Project Defaults information to clips (from Project->Setup), and to Apply  
 Camera Settings, which can automatically set a Source Aperture (region of interest) in the clip based on the  
 Cameras that have been defined.
• Generate any Deliverable (preset) - generate any of the available deliverables to an attached disk. When  
 this job is started the user can pick from any setting defined in Project->Deliverables.
• Generate ProRes 422LT (preset) - generate ProRes 422LT deliverables at 2048 x 1080 resolution to an  
 attached disk. 
• Generate DNxHD115 (preset) - generate DNxHD115 deliverables at 1920 x 1080 resolution to an attached  
 disk.
• Generate 10-bit RGB DPX (preset) - generate 10-bit RGB DPX deliverables at 4096 x 2160 resolution to an  
 attached disk. 
• PDF reports (preset) - save PDF reports for the selected clips. There are 2 types of PDF report that can  
 be saved. The Clip Report contains a summary of details for every selected clip. The QC Report contains  
 details of any QC notes made in Review.
• Audio Sync (preset) - sync the selected clips with audio files based on timecode. A browser will be shown  
 where the location of audio files can be selected. If there is an ‘audio’ folder containing wav/BWF files in the  
 same location as the video clip folders, these files will be used by default. After using this task, the sync can  
 be checked and adjusted in Vault Review.
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5. Storage
The image below shows the Storage screen:

The Volumes tab shows each loaded storage media (camera media, hard drive, LTFS tape) with details of the 
filesystem type, location, and space remaining. Select media and click the wrench to Eject.

The Devices tab shows attached devices, such as ports, media readers, and tape drives, and can be used to 
Load or Eject media by clicking the wrench. Codex media can be reformatted using the ‘Erase’ and ‘Create’ 
options - WARNING: there is no undo option after reformatting.

6. Project
The Project area is where you configure Codex Production Suite for your workflow. In the Project area you can:

• Input production information (Production Name, Director, etc.) from the Setup screen, which can be applied  
 to source clips using the Media Check task.
• Set up Cameras, so that a Source Aperture (region of interest) can be applied automatically to source clips  
 using the Media Check task.
• Set up Framings to determine the ‘region of interest’ in source clips, and how this is fitted into your   
 deliverables.
• Set up the different types of Deliverables required for dailies, editorial, VFX, etc.
• Set up Jobs which contain the tasks you need to run for your workflow.
• Set up the VFS (Virtual File System) to provide the file types and folder structure required.

Most screens of the Project area have a list of presets on the left. You can use the + button to add your own 
settings, or duplicate existing settings. The pencil icon, shown in various places, allows editing of the settings:
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6.1 Setup

The Setup screen is where you can input production details. These can be assigned to clips as part of a Media 
Check task. 

You can set the Project frame rate, which can be applied to any Deliverable. The Project frame rate also 
controls the frame rate of audio files that are linked into the Library, so it is important to set the Project frame 
rate correctly.

Set the Project root directory as the default location that you want to use for jobs such as Generate or Archive 
- this might be an attached RAID or network storage location. When the file browser is opened a folder marked 
with ‘P’ will be shown which is a shortcut to this location.
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6.2 Cameras 

There are a range of preset Camera Configurations available, but you can also add your own as required. The 
preset Cameras Configurations need to be edited by adding the relevant Source Aperture (region of interest) 
for your production.

The purpose of defining a Camera Configuration is because you want to automatically assign a Source 
Aperture to any clips on the system that match a particular resolution and, optionally, pixel aspect and 
metadata value. 

For example, you may want to perform the same 2.39 extraction on all 4K clips. Or on a multi-camera shoot 
you may want to perform a particular extraction on one camera, and a different extraction on the other, based 
on the camera serial number.

Once a Camera Configuration is defined it can be matched to clips as part of a Media Check task, using the 
Apply Camera Settings option.
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6.3 Framing

The Framing screen contains presets to cover the most common requirements. The left panel shows the full list 
of Framing Templates.

Framing Templates marked with an ‘S’ are Source templates, and can be applied to a clip. These are used to 
specify the region of interest you want to crop out of the original image. A Source Framing Template can be 
used with a Camera Configuration and applied with a Media Check Job->Apply Camera Settings, or from the 
Library->Metadata Panel->Edit Metadata->Set Source Aperture.

Framing Templates marked with a ‘D’ are Destination templates, and can be applied to a Deliverables. These 
are used to specify the resolution of the Deliverable, and whether the source image fills the whole Deliverable 
area, or whether some ‘safe area’ is left around the outside.

Source and Destination Framings can have a Pixel Aspect set. A Source Framing can only be applied to 
a clip that has the same Pixel Aspect. For Destination Framings, the Pixel Aspect determines if the image 
is squeezed when the Deliverable is created. For example, if a Deliverable is created using a Destination 
Framing with Pixel Aspect set to Anamorphic 2:1, the image content will be horizontally squeezed by a factor 
of 2, and is expected to be de-squeezed by the same factor in post production software.

From the Framing screen, there are a range of additional presets for ARRI and RED cameras that can be 
accessed by clicking on Wrench->Import XML. This will show a browser with folders for different camera 
formats, and these contain additional framing presets that can be imported by selecting one or more of the 
XML files.
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6.3.1 Configuring a Framing Template
Click the + icon to Add a Framing. Enter a descriptive Canvas Name and then set the Type as either Source or 
Destination. The settings then available depend on the Type selected.

When setting up a Framing template, the contents of the Description fields do not appear anywhere else in the 
software, but can be used to record information about the Framing preset you are creating for reference later.

Settings for Source Framings

Width and Height (of Canvas) - these must be set correctly to match the resolution of the clips that you want 
to apply the framing to.

Pixel Aspect - this must be set correctly to match the Pixel Aspect of the clips that you want to apply the 
framing to.

Aperture Name - enter a name for the region of interest that you want to extract from the source clip.

Width and Height (of Aperture) - enter the resolution of the region of interest that you want to extract from the 
source clip.

Left Offset and Top Offset - the region of interest will default to the top-left of the source image. To centre this 
region, click the symbol of four arrows next to the Top Offset box. Alternately, enter values for the Left Offset 
and Top Offset manually.

Settings for Destination Framings

Width and Height (of Canvas) - set these values to determine the resolution of the Deliverable file that will be 
created.

Pixel Aspect - set this to determine the squeeze factor applied to the source image when the Deliverable file 
is created. Deliverables such as .mov and .exr will contain this as metadata, allowing other applications to 
automatically apply the correct de-squeeze.

Aperture Name - enter a name for the area within the Deliverable that the source image will be fitted into.

Width and Height (of Aperture) - enter the resolution for the area within the Deliverable that the source image 
will be fitted into.

Left Offset and Top Offset - the source image will default to the top-left of the Deliverable area. To center the 
source image in the Deliverable, click the symbol of four arrows next to the Top Offset box. Alternately, enter 
values for the Left Offset and Top Offset manually.

Fit Mode - there are several options to determine how the source image is fitted into the Deliverable:

• Fit Width and Height - the whole source image will be scaled to fit into the width/height of the defined  
 Aperture size. None of the source image will be cropped (apart from the area outside any Source Aperture  
 that has been applied to the source clip).
• Fit Width - the source image will be scaled until the width matches the defined Aperture width. Any of the  
 source image above/below the Aperture area will be cropped if Crop Source is set to Yes.
• Fit Height - the source image will be scaled until the height matches the defined Aperture height. Any of the  
 source image left/right of the Aperture area will be cropped if Crop Source is set to Yes.
• Fill - the source image will be scaled until the whole Aperture area is filled. This will result in the cropping  
 of either the top/bottom or left/right of the source image if Crop Source is set to Yes, depending on the  
 relative aspect ratios of the source image and Aperture it is being fitted to.
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Crop Source:

• Yes - this setting will crop the source image to fit the Aperture area, based on the Fit Mode that is selected. 
• No - this setting will result in the source image being scaled and fitted into the Aperture area based on the  
 Fit Mode, but a crop will not be applied, so the source image may extend outside of the Aperture area.

6.4 Deliverables

The Deliverables screen is where you define the different types of files required for your project. For example, 
you may need to deliver H.264 files with a LUT for iPad dailies, Avid DNxHD 115 with no LUT for editorial, 
Open EXR files for visual effects work, and a RAW file type for final colour grading.  

Once a Deliverable is configured it can be used in a Generate job, and in the VFS.

6.4.1 Preset Deliverables
There are a range of presets that provide examples of how to set up a Deliverable:

• Camera Negative - this preset uses the ‘Camera Negative’ file type, and provides the source material in  
 the original format. For example, ARRIRAW material will be provided as .ari files, VariCam 35 material will be  
 provided as .vrw files, Codex Action Cam material will be provided as .cdx files.
• DPX 10-bit RGB (4096 x 2160) - this preset uses the DPX file type, and is configured to provide 10-bit RGB  
 DPX files. The ‘4K DCI> All’ aperture is used, meaning that all source material is scaled to 4096 x 2160. No  
 LUT or burn-in is applied.
• H264 (1280 x 720p) - this preset uses the H.264 file type. The ‘HD 720 > All’ aperture is used, meaning that  
 all source material is scaled to 1280 x 720. No LUT or burn-in is applied.
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• DNxHD115 (1920 x 1080) - this preset uses the mxf file type, and is configured to provide DNxHD 115 files.   
 The ‘HD > Avid safety 16:9’ aperture is used, meaning that the files will be 1920 x 1080 resolution, and the  
 source image will be scaled to 1888 x 1062 inside this (the remainder of the image area is black). An   
 example burn-in is applied that includes roll and clip name, masking, timecode, and a logo.
• DNxHD175X (1920 x 1080) - this preset uses the mxf file type, and is configured to provide DNxHD 175  
 files. The ‘HD > All’ aperture is used, meaning that the files will be 1920 x 1080 resolution. No LUT   
 or burn-in is applied.
• DNxHD444 (1920 x 1080) - this preset uses the mxf file type, and is configured to provide DNxHD 444 
 files. The ‘HD > All’ aperture is used, meaning that the files will be 1920 x 1080 resolution. No LUT   
 or burn-in is applied.
• ProRes 4444 (4096 x 2160) - this preset uses the mov file type, and is configured to provide ProRes 4444  
 files. The ‘4K DCI > All’ aperture is used, meaning that all source material is scaled to  4096 x 2160. No LUT  
 or burn-in is applied.
• ProRes 422 LT (2048 x 1080) - this preset uses the mov file type, and is configured to provide ProRes 422  
 LT files. The ‘2K DCI > All’ aperture is used, meaning that all source material is scaled to 2048 x 1080. The  
 LUT is set as {CDLData}, meaning that if a clip has a CDL look stored in metadata then this will be applied.
• ProRes 422 HQ (2048 x 1080) - this preset uses the mov file type, and is configured to provide ProRes 422  
 HQ files. The ‘2K DCI > All’ aperture is used, meaning that all source material is scaled to 2048 x 1080. No  
 LUT or burn-in is applied.
• ProRes 422 HQ (4096 x 2160) - this preset uses the mov file type, and is configured to provide ProRes 422  
 HQ files. The ‘4K DCI > All’ aperture is used, meaning that all source material is scaled to 4096 x 2160. No  
 LUT or burn-in is applied.
• ProRes 4444 (2048 x 1080) - this preset uses the mov file type, and is configured to provide ProRes 4444  
 files. The ‘2K DCI > All’ aperture is used, meaning that all source material is scaled to 2048 x 1080. No  
 LUT or burn-in is applied.
• ProRes 4444 (4096 x 2160) - this preset uses the mov file type, and is configured to provide ProRes 4444  
 files. The ‘4K DCI > All’ aperture is used, meaning that all source material is scaled to 4096 x 2160. No  
 LUT or burn-in is applied.
• ProRes 4444 XQ (2048 x 1080) - this preset uses the mov file type, and is configured to provide ProRes  
 4444 XQ files. The ‘2K DCI > All’ aperture is used, meaning that all source material is scaled to 2048 x 1080.  
 No LUT or burn-in is applied.
• ProRes 4444 XQ (4096 x 2160) - this preset uses the mov file type, and is configured to provide ProRes  
 4444 XQ files. The ‘4K DCI > All’ aperture is used, meaning that all source material is scaled to 4096 x 2160.  
 No LUT or burn-in is applied.

Some of these Deliverables are used in the preset Jobs, and some are in the preset VFS templates. Click the + 
icon to Duplicate one of these Deliverables and customise it for your own use.

6.4.2 Configuring a Deliverable Template
Click the + icon to Add a Deliverable. Enter a descriptive Template name and then select a File type from the 
drop down list. The settings available depend on the file type selected.

When setting a LUT, the following options are available from the Add button:

• LUT - this option allows the selection of a LUT file from the computer. See details below about how to   
 automate selection of ALEXA LUTs based on the Exposure Index of the clip being processed.
• CDL - this option will apply a look based on CDL metadata that is stored with the clip.
• Pre/CDL/Post - this option will apply the Pre LUT, CDL, and Post LUT that can be set on the clip using  
 Review.
• Live Look - this option will apply the Live Look that is stored with the clip. A Live Look can be set on a clip  
 using either Review from the Live Looks panel, or from Library->Edit Metadata->Clip Info->Live Look.
• Camera Look - this option will apply any embedded look data that was set in the camera from ALEXA  
 ARRIRAW or VariCam 35 VRAW.
More than one LUT or colour transform can be applied. For example, if you require CDL, plus a 3D LUT, plus 
a range adjustment LUT, these can be added sequentially so that the contents of the Lut field looks something 
like:
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{CDLData}; arri/arri.logC.rec709.EI1000.ee.3d.lut; range_EL.lut 

When using the Add Lut button there are a range of preset LUTs for different camera systems. The presets 
are mostly 3D LUTs that perform a camera log to Rec. 709 conversion. An example LUT file name is ‘arri.logc.
rec709.EI1000.ee.3d.lut’, and the file name describes: <SourceCamera>.<SourceColourspace>.<TargetColo
urspace>.<SourceExposureIndex>.<OutputRange>.<LutType>.extension. The OutputRange of ‘ee’ indicates 
extended range (black=0, white=1024 in output file) while ‘el’ indicates legal range (black=64, white=940 in 
output file).

Where a set of LUTs are provided for a range of exposures you can configure the system to select the correct 
LUT based on the exposure of the clip. First select a LUT from the set provided. Then, in the LUT field edit the 
name so that the exposure value is replaced with the metadata tag {ExposureIndex}, e.g. arri/arri.logC.rec709.
EI{ExposureIndex}.ee.3d.lut. This means that for every clip, the correct LUT will be applied based on the 
ExposureIndex value in the clip metadata.

To use custom LUTs click the Add->LUT button and navigate to the LUT file using the browser. Custom LUTs 
can be installed in /Library/Application Support/Codex/luts on OS X, or /etc/codex/luts on Vault S/XL-Series, 
which is the default location for the browser when using the Add->LUT button.

The Destination Aperture setting determines the size of the file that will be created, and whether the source 
image is fitted fully into this, or whether the source image only fills a portion of the total image area. See the 
additional guide ‘Using Framings In Vault Platform’ for more information and examples.

The Source region setting controls whether the whole source image (Full canvas) or only the area set by the 
Source aperture (Aperture) is included in the created files.

The FPS setting can be used to force all created files to a particular frame rate. The Original setting will create 
files at the same frame rate as the source clips. The Project setting will create files at the frame rate set in 
Project->Setup->Project framerate.

To apply metadata overlays on the created files, choose Burn-in->Add and select from the preset templates of 
metadata to add. The template names indicate the metadata that will be added and the position on the image.  
You can repeat the process to add multiple metadata overlays to different parts of the image.

The Roll transform setting can be used to add a channel ID to the beginning (Prepend chan ID) or end 
(Append chan ID) of the Roll number in the metadata of the files that are created. This is mainly used for dual-
camera/stereo recordings on Codex recorders, but can be used on any clip that has metadata for ‘ChannelID_
V1’ or ‘ChannelID_V2’.

The Colour space of many available file types can be either Camera Native, or ACEScc. Open EXR files can 
be created in ACES linear space, or ALEXA Wide Gamut space (for ARRIRAW clips only). When ACEScc or 
ACES is selected the software will apply an IDT to take the image into this colour space. IDTs are built into the 
software for many of the supported camera formats.

The options available for Type depend on the selected File type. For example, mov files can be created as 
ProRes, DNxHD, Photo JPEG, or Motion JPEG. If ProRes is selected then the Compression can be set as any 
of the available ProRes compression options (Proxy, 422 LT, 422, 422 HQ, 4444, 4444XQ).

The Processing option determines the quality of scaling, colour conversion, and Codex debayering operations. 
It is recommended to set this to ‘High quality’ to get the best result. Different scaling filters are used depending 
on the setting:

• High quality - Lanczos, optimal Codex debayer.
• Medium quality - Mitchell, optimal Codex debayer unless the file created is less than half the resolution of  
 the source clip, in which case a lower quality Codex debayer is used.
• Low quality - Cubic, optimal Codex debayer unless the file created is less than half the resolution of the  
 source clip, in which case a half-scale Codex debayer is used.

For ‘exr’, ‘dpx’, ‘mov’ and ‘mxf’ file types the ‘ARRIRAW’ and ‘Sony Debayer’ settings can be used to select the 
manufacturers debayer algorithm instead of the Codex debayer algorithm.
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6.5 Jobs

The Jobs screen is where you define templates containing the tasks required for your workflow. There are a 
range of presets, covered in the earlier Preset Jobs section.

Click the + icon below the list of Job Templates to Add a Job. Enter a descriptive Template name for the Job 
and then click the + icon below to add one or more tasks. The settings available depend on the Job type 
selected, and are covered in the next sections.

A Job contains one or more tasks that can either run in sequence or in parallel depending on how the template 
is set up. 

The Start of the Job can be set to Manual and/or Automatic. When set to Manual, the Job must be started from 
the Library. 

When set to Automatic, the Job will start when media is loaded into the port specified in the ‘From’ field.

The different types of Jobs available are:

• Archive - backup the camera negative files to either disk or LTFS tape. The Operation can be set to   
 ‘Backup’, ‘Backup and verify’, or ‘Verify’. ‘Backup and verify’ is recommended as this copies the files to the  
 destination and then reads them back, performing an md5 verification against the source files. The ‘Add  
 other files’ option allows you to choose another folder of files to be included with the archive - for example if  
 you have master sound files that also need to be archived. The Archive tasks writes image, audio, and  
 metadata files to the destination in the manufacturers preferred structure.
• Clone - make a copy of the original clips from camera media to attached storage or a Transfer   
 Drive in Vault S/XL-Series. An internal CRC32 verification is performed as files are copied. The Clone   
 task writes image, audio, and metadata, and the copied clips are immediately linked back to the Library. 
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• Generate - output files using one of the defined Deliverables. Typically this task is used to create files for  
 dailies, editorial, and VFX.
• Import - import clips to Codex media.
• Media Check - get a summary of the selected media (number of clips, frames, clip format). Also this task  
 can be used to apply Project metadata information such as ‘Production name’ and ‘Director’ to clips (from  
 Project->Setup), and to automatically set a Source Aperture (region of interest) to be applied to the clip  
 based on the Cameras that have been defined.
• Media Verify - verify that no corruption has occurred to clips, and that they still match with the original  
 checksums. This is not needed as part of a normal workflow, but can be used if the software reports a CRC  
 error during another task.
• Media Clear - format Codex media.
• Media Sign Off - mark Codex media as ‘signed-off’, which means you have finished working with it and it is  
 safe to delete the contents using the Media Clear task.
• Match Look - part of the workflow with Codex Live software. Looks saved when using Codex Live can be  
 matched to clips using this task. Timecode is used to match a look to a clip.
• Link - add files to the Library without making a copy of them. When this job is started a file browser is   
 shown where you can pick a source folder containing clips you want to link to the Library. (This happens  
 automatically as part of the Clone task.)
• Reports - save PDF reports for the selected clips. There are 2 types of PDF report that can be saved. The  
 Clip Report contains a summary of details for every selected clip. The QC Report contains details of any QC  
 points applied to clips using Review. Each report has a record of Production Name and Shoot Date. 

This metadata must be added to the clips in order to appear in the report.

Each Job can be configured with a ‘From’ setting (the source where the clips are coming from) and/or a ‘To’ 
setting (the destination where the clips/files are going to). The ‘From’ setting is optional - if the template does 
not have a pre-configured ‘From’ setting (that is, it contains the default ‘<enter input expression>’) then the 
selection in the Library will be used, or if there is no Library selection you will be asked to select the source 
when the Job is started. 
 
Next to the ‘From’ and ‘To’ settings click the ‘...’ button to open a chooser where you can pick the source/
destination for the Job. The options that specify ‘any’ (e.g. ‘Any SxS’) mean that the system will use any 
connected media reader/port of that type. In the ‘Common Expressions’ options, choose ‘Any directory’ to be 
able to pick from any source/destination folder on the system when the job starts.
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The table below provides details of the ports/readers that are supported, and which expression to use:

Category Name In Vault Platform Mac OS X reader Vault S-Series port Vault XL-Series port
Internal Ports Codex INT 1 NA 8TB Fixed Internal Storage, 

module 1
NA

Codex INT 2 NA 8TB Fixed Internal Storage, 
module 2

NA

Any Codex INT NA 8TB Fixed Internal Storage, any 
module

NA

Codex TD 1 NA Transfer Drive (removable) module 
1

Transfer Drive (removable) module 1

Codex TD 2 NA Transfer Drive (removable) module 
2

NA

Any Codex TD NA Transfer Drive (removable) any 
module

Transfer Drive (removable) any module

Any Codex INT or Codex TD NA 8TB Fixed/Transfer Drive, any 
module

8TB Fixed/Transfer Drive, any module

Codex Ports Codex CD2 NA Capture Drive 2.0 Port Capture Drive 2.0 Port

Codex CD1 - Port 1 NA Capture Drive Port - CODEX 1 NA

Codex CD1 - Port 2 NA Capture Drive Port - CODEX 2 NA

Codex CD1 - Port 3 NA Capture Drive Port - CODEX 3 NA

Codex CD1 - Port 4 NA Capture Drive Port - CODEX 4 NA

Any Codex CD1 - Port NA Any Capture Drive Port NA

Codex OB NA Onboard Data Pack Port NA

Codex CD1 - SAS Port 1 Capture Drive Dock (SAS) 
Port 1

Capture Drive Dock (SAS) Port 1 Capture Drive Dock (SAS) Port 1

Codex CD1 - SAS Port 2 Capture Drive Dock (SAS) 
Port 2

Capture Drive Dock (SAS) Port 2 Capture Drive Dock (SAS) Port 2

Any Codex CD1 - SAS Port Any Capture Drive Dock 
(SAS) Port

Any Capture Drive Dock (SAS) Port Any Capture Drive Dock (SAS) Port

Codex OB - SAS Desktop Transfer Station 
(SAS)

Desktop Transfer Station (SAS) Desktop Transfer Station (SAS)

Codex CD1 - USB Capture Drive Dock (USB-3) NA NA

Codex CD1 - TB Capture Drive Dock (TB) NA NA

Codex CD2 - TB Capture Drive 2.0 Dock (TB) NA NA

Third Party Ports AXSM 1 Sony AXS-CR1 AXSM 1 port NA

AXSM 2 Sony AXS-CR1 AXSM 2 port NA

Any AXSM Sony AXS-CR1 Any AXSM port NA

RED 1 REDSTATION - REDMAG, 
REDMAG MINI, RED 
MINIMAG

RED port 1 NA

RED 2 REDSTATION - REDMAG, 
REDMAG MINI, RED 
MINIMAG

RED port 2 NA

Any RED REDSTATION - REDMAG, 
REDMAG MINI, RED 
MINIMAG

Any RED port or RED STATION NA

SxS 1 Sony SBAC-US30, Sony 
SBAC-UT100

SxS port 1 NA

SxS 2 Sony SBAC-US30, Sony 
SBAC-UT100

SxS port 2 NA

Any SxS Sony SBAC-US30, Sony 
SBAC-UT100

Any SxS port NA

Any Cfast Codex Cfast 2.0 Reader Codex Cfast 2.0 Reader NA

Any P2 Panasonic AU-XPD1 NA NA

SR Memory 1 NA SR Memory port 1 NA

SR Memory 2 NA SR Memory port 2 NA

Any SR Memory NA Any SR Memory port NA

When there is more than one task in the Job template, the ‘Run after’ settings control the order of tasks. The 
default is that a task will run after the previous task, but this setting can be used to change the order, and 
allows tasks to be run in parallel. For example, set tasks to ‘Run after: None’ and they will all start at the same 
time. 
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6.5.1 Archive task settings
Operation:

• Backup - files will be written to disk or tape (depending on other settings), and md5 checksums will be  
 created. After files are written they will not be read back and verified.
• Backup and verify - files will be written to disk or tape (depending on other settings), and md5 checksums  
 will be created. After files are written they will be read back and verified against the source files.
• Verify - files will be read back and verified against the md5 checksums created when the archive was first  
 written.

Archive name prefix:

• Default - when the archive is created, the Default name for the top level folder includes a unique time and 
date stamp in the format ‘archive_YYYYMMDD_HHMMSS_<archive_name>’, where the <archive_name> 
can either be auto or manual, as described below.

• None - the ‘archive_YYYYMMDD_HHMMSS_’ details are not included, so the name of the top level folder is 
based only on the name entered by the user. 

Auto naming:

• No - when the archive is started the user will be prompted to enter a name. This would typically   
 summarise the contents of the archive, e.g. ‘Day-56’, or ‘Rolls-A001-A002-B001’. When the archive is   
 written the files are contained in a top level folder that is named in the format: archive_YYYYMMDD_   
 HHMMSS_<archive_name>. For example, if the archive name was entered as ‘Day-56’, the archive name  
 could be: ‘archive_20160505_160142_Day-56’.
• Yes - when this setting is selected an additional option is shown for ‘Auto name prefix’. In this field   
 enter a name that will be applied to each archive. This can be used to reduce the amount of information  
 the user is prompted to enter at the beginning of the archive. Each time an archive is run, a number   
 will be appended to the end. For example, if ‘Auto name prefix’ is entered as ‘my-project’ then archive  
 names could be: ‘archive_20160505_160142_my-project’, ‘archive_20160505_192133_my-project(2)’,  
 ‘archive_20160506_094712_my-project(3)’.

Number of LTFS archives - this sets the number of tapes that will be written to during the archive. Options are 
0, 1, or 2. If the tapes are not already formatted, they will be formatted with an LTFS (Linear Tape File System) 
at the beginning of the archive.

Number of disk archives - this sets the number of disks that will be written to during the archive. Options are 
0, 1, or 2.

Predefine file path:

• No - when this setting is selected the user will be prompted to enter the file path (disk location) at the   
 beginning of the archive. 
• Yes - when this setting is selected an additional option is shown for ‘Destination file path’. Click the ‘...’  
 symbol to choose the file path (location) of the disk to be used for the archive. This can be useful if you  
 always want to archive files to the same location.

Auto destination name:

• No - when this setting is selected the user will be prompted to enter a name for the disk location at the  
 beginning of the archive. This name is logged by the system for tracking purposes.
• Yes - when this setting is selected an additional option is shown for ‘Destination media name’. In this   
 field enter a name for the disk that will be used for the archive. This can be used to reduce the amount of  
 information the user is prompted to enter at the beginning of the archive.

Frame rate - by default files will be archived at the Original frame rate, and this is the recommended setting. 
If required the files can be forced to a different frame rate in the archive. This option will affect only files stored 
on media formatted with a Codex File System.
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Add other files:

• No - when this setting is selected no other files will be included in the archive other than those clips selected  
 in the Library.
• Yes - when this setting is selected an additional option is shown for ‘Other files location’. Click the ‘...’   
 symbol to choose the file path (location) of the other files to be included in the archive. This can be useful  
 if you always want to include some files that cannot be loaded into the Library - for example PDF reports, or  
 camera sheet scans.

6.5.2 Audio sync task settings
Matching rule:

• Timecode only - video and audio clips will be matched if there is a minimum 30% timecode overlap.
• Timecode and roll - video and audio clips will be matched if there is a minimum 30% timecode overlap and  
 the roll metadata also matches.

Auto name matching group:

• Automatic - when the Audio Sync task is run, a group will automatically be created for video clips that were  
 successfully sync’d. When this setting is used the group will be named automatically in the format: ‘Audio  
 Sync YYYY/MM/DD HH:MM:SS’.
• Manual - when this setting is selected an additional option is shown for ‘Matching name prefix’. In this field  
 enter an alternate prefix for the name of the group created of clips that have been sync’d successfully.

Create group for failures:

• No - for any video clips that could not be sync’d to audio clips, no group will be created by default.
• Yes - when this setting is selected a group will be created for video clips that could not be sync’d to   
 audio clips. The group of clips will be named automatically in the format: ‘Audio Sync Failures YYYY/MM/DD  
 HH:MM:SS’.

Auto name fail group:

• Automatic - when ‘Create group for failures’ is set to Yes, the group created will default to the name format  
 detailed above. 
• Manual - when this setting is selected an additional option is shown for ‘Fail name prefix’. In this field enter  
 an alternate prefix for the name of the group created of clips that could not be sync’d.

Video clip metadata:

• Keep original - when this setting is selected, no metadata will be extracted from the audio clips and applied  
 to the video clips.
• Copy from audio file - when this setting is selected the following metadata items can be highlighted to be  
 extracted from the audio clips and applied to the video clips during the sync process: Scene, Take, Shoot  
 Date, Audio Track Names, Creation Time.

6.5.3 Clone task settings
The Clone task does not have any settings, and requires only a From and To expression to determine the 
source and destination. Clips are copied from camera media to attached storage or an 8TB Transfer Drive in 
Vault S/XL-Series. An internal CRC32 verification is performed as files are copied. The Clone task writes image, 
audio, and metadata, and the copied clips are immediately linked back to the Library. 
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6.5.4 Generate task settings
Deliverable - this can be set to ‘Specify at launch’, or to a specific Deliverable that is configured. When set to 
‘Specify at launch’, upon starting the Generate task the user is presented with a list of the Deliverable options 
configured on the system. When set to a specific Deliverable the Generate task will always transcode to that 
format.

Predefine directory:

• No - when this setting is selected, the user will be prompted to choose the destination for the Generate task  
 when it is started.

• Yes - when this setting is selected an additional ‘Directory’ option is shown. Click the ‘...’ button to choose a  
 destination for the Generate task. This can be useful if you always want to write files to the same destination.

Base directory - this setting determines the folders that will be created above the files that are generated. 
There are four options, depending on which file type is being created:

• {Roll} - this setting is suitable for stream file types, such as ProRes mov or DNxHD mxf.
• {Roll}/{Shot} - this setting is suitable for sequence file types, such as dpx or exr.
• {ProductionName}/{ShootDate}/{Day}/{Roll} - this setting is suitable for stream file types, such as ProRes  
 mov or DNxHD mxf.
• {ProductionName}/{ShootDate}/{Day}/{Roll}/{Shot} - this setting is suitable for sequence file types, such  
 as dpx or exr.

Video filename:

• Default - when this setting is selected, files created will use the clip name as shown in the LIbrary. For  
 files that require a sequence number (e.g. dpx or exr), the numbering will be based on the timecode of each  
 frame, expressed as ‘frames-since-midnight’. One exception is rmf (Canon RAW) files, that use ‘frame-in- 
 clip’ numbering.
• Custom - when this setting is selected an additional option is shown for ‘Custom video filename’. In this field  
 enter tokens or the name of a metadata property in braces to determine how the files will be named. There  
 are full details on the standard tokens and metadata property names later in this guide.

Stereo filename - this setting works in the same way as ‘Video filename’ detailed above, but applies only to 
clips that contain 2 video channels, captured on either a Codex Onboard Recorder or Codex Action Cam.

Audio filename - this setting works in the same way as ‘Video filename’ detailed above, but applies only to 
audio files that are created.

First frame - by default files generated will contain all frames from a clip. This setting can be used to specify if 
you want the files generated to begin a specific number of frames from the start of the clip.

Number of frames - this setting can be used to specify if you only want to generate a limited number of 
frames, rather than all the frames in a clip. This can be useful during testing/prep to create smaller files, or 
shorter file sequences.

Eject external media:

• Prompt - when this setting is selected the user will be prompted as to whether they would like to eject the  
 target disk at the end of the Generate task.
• Yes - when this setting is selected the target disk will be ejected automatically at the end of the Generate  
 task.
• No - when this setting is selected the target disk will not be ejected at the end of the Generate task.
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6.5.5 Import task settings
Source:

• File - when this setting is selected files will be imported from a disk storage location. The import process will  
 search recursively through directory trees to identify any files that can be imported. Files will be imported to  
 Codex media based on the input expression in the ‘To’ field.
• Tape - when this setting is selected files will be imported from LTFS tape. The tape must contain files written  
 using the Archive task. Tapes written with other methods cannot be imported. Files will be imported to  
 Codex media based on the input expression in the ‘To’ field.

Number of frames - by default all frames of a clip will be imported. This setting can be used to limit the 
number of frames that will be imported for each clip.

Predefine file path:

• No - when this setting is selected the user will be prompted to enter the source file path (disk location) at the  
 beginning of the import. 
• Yes - when this setting is selected an additional option is shown for ‘File path’. Click the ‘...’ symbol to   
 choose the source file path (location). This can be useful if you always want to import files from the same  
 location.

6.5.6 Link task settings
Predefine file path:

• No - when this setting is selected the user will be prompted to enter the path (disk location) for files to link to  
 at the beginning of the Link task. 
• Yes - when this setting is selected an additional option is shown for ‘File path’. Click the ‘...’ symbol to   
 choose the source file path (location). This can be useful if you always want to link to files from the same  
 location.

Recursive:

• Yes - when this setting is selected the Link task will search down from the specified location into all sub- 
 directories to identify files that can be linked to.
• No - when this setting is selected the Link task will only check the specified directory to identify files that can  
 be linked to.

6.5.7 Media Verify task settings
Create CRC32 samples:

• Disable - when this setting is selected, the Media Verify will not add checksums to files on media formatted  
 with a Codex file system.
• Enable - when this setting is selected, the Media Verify will add checksums to files on media formatted with  
 a Codex file system.

Repair CRC32 samples:

• Disable - when this setting is selected, the Media Verify will not repair any checksums that are detected as  
 incorrect for the source data.
• Enable - when this setting is selected, the Media Verify will repair any checksums that are detected as  
 incorrect for the source data.
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6.5.8 Media Clear task settings
Create new volume:

• No - when this setting is selected, a new Roll will not be created on Codex media as part of the Media Clear  
 task.
• Yes - when this setting is selected, a new Roll will be created on Codex media as part of the Media Clear  
 task.

User sets new label:

• No - when this setting is selected, a new Roll number will be automatically assigned to the media,   
 incremented from the previous Roll number.
• Yes - when this setting is selected, the user will be prompted to enter a new Roll number during the task.

6.5.9 Reports task settings
Default report directory - click the ‘...’ button to choose a destination for saving reports. This can be useful if 
you always want to save reports to the same destination. If this field is left blank the user will be prompted to 
choose a destination when the Reports task is run.

6.6 VFS

The VFS (Virtual File System) screen is where you set up the file types available from the ‘Codex VFS’. On Mac 
OS X the ‘Codex VFS’ is a drive that appears on the Desktop. On Vault S/XL-Series the ‘codexvfs’ is a network 
shared drive. 
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The VFS provides another way to access master files and perform transcodes. Once the VFS is configured 
then clips are always available in the ‘Codex VFS’ drive, ready to be copied. The system only performs the 
transcoding when the files are copied, but the size of the files can be checked in the VFS prior to copying.

The default setting uses the ‘Camera Negative’ file type, and provides the source material in the original format.  
For example, ARRIRAW material will be provided as .ari files, VariCam 35 material will be provided as .vrw 
files, Codex Action Cam material will be provided as .cdx files.

There are alternate presets available for ProRes 4K, ProRes 2K, and DNxHD file types. To enable a different 
preset click ‘Disable VFS’, then select the radio button next to the configuration name, then click ‘Enable VFS’.

Click the + icon to Add a VFS Configuration. Enter a descriptive Configuration name and then click the circle 
icon next to a Deliverable to add it. You can have more than one Deliverable active in a VFS Configuration.  

The Parent directory and Global filter settings can be left at their defaults. This will not add any additional top 
level directories (for all file types), and will mean all clips on the system are available through the VFS. 

To add a top level directory enter the details in the Parent directory field. This could be a text string, or a 
metadata property name, e.g.

Parent directory - /MyProject/Deliverables/
Parent directory - /{ProductionName}/{ShootDate}/

A full list of metadata property names is available in the later section ‘Metadata Property Names and Labels’.

The Global filter can also be set using metadata property names, e.g.

Global filter - {OriginalRoll} = “A001”
Global filter - {ProductionName} = “MyProject” 

The Path for each Deliverable must be set correctly for files to be presented in the ‘Codex VFS’ drive.  

The recommended setting for image sequences such as .ari, .dpx, .cdx is: 

{r}/{s}/{s}.{g%7}.{e} 

This gives a filename of /<Roll>/<Clip>/<Clip>.<FrameNumber>.<Extension>

The recommended setting for stream files such as .mov and .mxf is: 

{r}/{s}.{e} 

This gives a filename of /<Roll>/<Clip>.<Extension>

Click ‘Enable VFS’ and click the circle next to the Configuration name to make the files available in the ‘Codex 
VFS’ drive. The image below shows a VFS Configuration for ProRes 422 LT and DPX:
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7. Job Queue

The Job Queue screen shows the progress of jobs that are running. Jobs can be paused and stopped with the 
buttons as required. If user input is required, for example to choose the target directory, then an Alert will be 
shown. The Job Queue displays when a task has completed, or information if any errors occur during a task.
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8. Preferences

8.1 System

The System screen provides the following areas:

• Feature Licensing - shows the hardware key required by Codex to generate a licence for the system) and  
  details of features licensed on the machine.
• Media History - allows you to ‘Clear Media History’. This is advised before the start of a new project, as the  
 system keeps a record of Roll names and will present warnings if duplicate Roll names are detected.
• Live - after exporting ‘Live Data’ (all looks) from Codex Live, use Import to bring this data into Production  
 Suite for use in Review.
• Logging - allows you to save log files from the machine to provide to Codex Support. Default level should  
 generally be used - Full level should be provided in the event of issues with the Archive task.
• Library - allows you to set the behaviour of the Play button that is shown on the focused thumbnail in the  
 Library.
• Screensaver - allows you to set a time for automatic logout from Vault Platform if there is no activity.
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8.2 Users

The Users screen shows a list of the user accounts for the Codex Production Suite software. You can edit 
details for the user account, and set a password to restrict access.

Click the pencil icon next to a user name to modify details and set the password.

8.3 About
The About screen displays information about the installed software version, and also displays licence 
agreements for third party libraries used by the software.

9. Keyboard Shortcuts
Press Ctrl-H to view keyboard shortcuts. These can be used to quickly and easily move between the main 
screens of the Vault Platform User Interface:

Ctrl + F (OS X) - Toggle fullscreen mode
Ctrl + T (S-Series) - Toggle touch-screen mode, to show mouse cursor and hide on-screen keyboard

Cmd + L (OS X), Ctrl + L (S/XL-Series) - Go to the Library view
Cmd + S (OS X), Ctrl + S (S/XL-Series) - Go to the Storage view
Cmd + J (OS X), Ctrl + J (S/XL-Series) - Go to the Job Queue view
Cmd + I (OS X), Ctrl + I (S/XL-Series) - Go to the Preferences view
Cmd + P (OS X), Ctrl + P (S/XL-Series) - Go to the Project view
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10. Supported file formats and codecs
The following source file formats and codecs can be used with Production Suite:

• ARRI ALEXA Classic/XT/SXT/Mini - ARRIRAW (16:9, 4:3, Open Gate), all ProRes variants.
• ARRI AMIRA - all ProRes variants.
• Panasonic VariCam 35 - VRAW (UHD and 4K, 10-bit and 12-bit).
• Canon C500 - Canon Cinema RAW (UHD and 4K).
• Canon C300 Mark II - XF-AVC MXF.
• Sony EX3 - MPEG-2 MXF.
• Sony F5, F55, and F65 - Sony RAW MXF, XAVC MXF.
• GoPro Hero - H.264.
• RED - REDCODE RAW R3D.
• Phantom Flex 4K - Cine files.

11. Custom file naming in the Generate task and VFS
For custom file naming in deliverables, any metadata field (such as Roll, Scene, Take) can be referred to by 
using the property name of the field enclosed in {braces} – for example {Scene}. Metadata fields used in this 
way are called tokens.

When the deliverable file is created, these tokens are then replaced by the value of that field from the source 
clip. For example, a custom file name could be:

{Scene}-{Take}

Then for each clip the tokens will be replaced by the Scene and Take values. If the clip metadata has a Scene 
value of 14 and a Take value of 5, the deliverable file name would be:

14-5

Deliverable files also need a file type extension, for which the {e} token should be used. With a custom file 
name of {Scene}-{Take}.{e}, the deliverable files would be named with the correct extension, for example:

DPX: 14-5.dpx
MOV: 14-5.mov

11.1 Rules for Token-Names
All metadata is described by internal property names, which are ultimately what the token-replacement system 
uses: the built-in ones are listed in the section ‘Metadata Property Names and Labels’ and have to be case-
sensitive and without spaces. Examples are ProductionName and CircleTake.

However, the user interface presents metadata fields with ‘friendly’ names for improved readability. These 
names are not case-sensitive and may contain spaces.

It is possible to modify the metadata views, such as Filecard or Project, if you need to add your own custom 
fields. Users wanting to perform such customisation should contact support@codexdigital.com for further 
details.

There are also a number of single-letter tokens. Some of these are for convenience - for example {r} is the 
same as {OriginalRoll} – but they are mainly for special purposes when setting up custom file naming. For 
example, if you are generating dpx files - which are one-per-frame - {f} can be used to put the frame-number in 
each filename. There is a full list of all legal token-names in ‘Metadata Property Names and Labels’.
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11.2 Metadata Property Names and Labels
User Friendly Label Metadata Property Name Synonym
Production ProductionName
Production Company ProductionCompany
Unit ProductionUnit
Director Director
DoP DirectorOfPhotography
Camera Assistant CameraAssistant
Codex Operator CodexOperator
Sound Recordist SoundRecordist
Name ShotName {s}
Roll OriginalRoll {r}
Scene Scene
Take Take
Shot Shot
Slate Slate
Circle Take CircleTake
Shot Type ShotType
Interior / Exterior IntExt
Day / Night DayNight
Comments Comments
T-Stop Tstop
Focus Focus
Lens LensType
Filter Filter
Source Type SourceType
Source ID SourceId
Source Name SourceDevice
Serial No SourceSerial
Shutter Angle ShutterAngle
Snapshot Snapshot
Date Date

11.2.1 Single-letter tokens
{s}  Clip name
{r}   Roll name
{d}  Clip recording date (which is not the same as using the {ShootDate} token)
{D}  Clip recording date and time
{f}   Frame number
{e}  Extension (file type)
{c}  Channel number (Video and Audio)
{C}  Channel ID, from ChannelId_V1 and ChannelId_V2 metadata
{t}   Timecode (as hhmmssff string)
{T}  Start timecode of clip
{g}  Timecode (as frame count from midnight)
{G}  Start timecode (as frame count from midnight}
{n}  Total number of frames in the clip
{b}  Userbit per frame
{B}  Start userbit for clip
{L}  Port description (i.e. where media is loaded)
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12. Vault Review
12.1 Introduction
Vault Review allows you to playback any clips from your Production Suite Library, as well as perform primary 
colour correction for dailies, audio synchronisation, QC of images, and export of colour corrected stills. Looks 
are applied non-destructively and can be saved to the Look Library to be applied to other clips. Vault Review 
integrates with Codex Live to allow looks designed on-set to be applied and further adjusted before rendering 
deliverables for post production. Review supports CDL and a range of 3D LUT formats created in other 
applications.

12.2 Supported Hardware
Vault Review can run on Mac OS X, Vault S-Series (with Review module) and Vault XL-Series.

The software can be controlled with a keyboard and mouse, with a range of keyboard shortcuts available.

It integrates with the Tangent Element series, Tangent Ripple, or Tangent Wave panels.

For video output from Mac Pro or MacBook Pro, Vault Review can be used with:

• AJA Io4K can be used to output to an SDI video monitor, from HD up to 4K resolutions.
• AJA T-Tap can be used to output to an SDI video monitor, from HD up to 2K resolutions.

In order to use an AJA Io4K or AJA T-Tap for SDI output, you will need to install the device drivers available on 
the AJA website.
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13. Launching Vault Review
 
To launch, select the clips in the Library, then click Vault Review in the Tools panel. 

13.1 Vault Review - Overview
Vault Review allows playback of any clips loaded in the Library. It can be used for primary colour correction, 
saving Looks, and to sync with Looks created in Codex Live. QC Marks can be added to any of your clips. 
Audio clips from the Library can be synced with any of your loaded video clips. Playback can be viewed from 
the Vault S-Series/XL-Series GPU and SDI outputs, directly on your Mac, or to an external monitor via SDI using 
an AJA Io4K or T-Tap.
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13.2 Configuration Options
The Configuration Options can be accessed by clicking the Blue Ring in the top left of screen. From this menu 
you can choose an external SDI Output Device, set the playback frame rate, select your Audio device and 
Audio Volume (Mac only).
 

Select Viewport

Select SDI
Output Aperture

Processing
(Quality playback)

Sensitivity Controls
Choose SDI

Output Aperture

Codex Blue Ring

The output resolution can be set from the SDI menu. Once an SDI output device is successfully detected, then 
options for Aperture, Link and Bit Depth will appear. 

The Aperture setting allows you to add a Destination Aperture to your SDI Output. (Please see section 6.3 
Framing for more information). 

Use the Link dropdown menu to set the SDI output as a 3G 444, 3G 422, 1.5G Dual Link 444 or 1.5G Single 
Link 422.

Bit Depth allows you to choose between a 10-bit or 12-bit SDI output signal.

Processing allows you to choose between quality settings to optimise playback for your hardware.

Sensitivity Controls include Printer Lights step (0.25 to 1) and Colour Ball sensitivity.
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13.3 Transport Controls

Next or
Previous Clip

Play Forwards
or Backwards

Frame Step
Forwards or 
Backwards

Playback
Speed

Stop, Loop, Bounce

Playback Full Clips or 
within In/Out Points

Play Single/Play All Clips Playhead Play Queue

The transport controls are located at the bottom of the screen. 

Clip selector - The Next or Previous Clip controls allow you to select which clip to playback, or simply click in 
the centre of the control to select from a list of loaded clips.

Play Forwards or Backwards controls allow you to choose to play your clip forwards or backwards. Clicking 
the control during playback will pause at the current frame.

Frame Step Forwards or Backwards allows you to step through frames one at a time.

Playback Speed allows you to choose between x0.5, x1.0, x.2.0, x3.0, x4.0 or x5.0 playback speeds.

Set playback of a Single clip or All of the currently loaded clips with the Play Single / Play All Clips control.

Clip Playback Behaviour - Stop, Loop or Bounce; Stop at end of clip(s), Bounce - play in reverse at end of 
clip(s), Loop back to start at end of clip(s). This applies to the current clip only in Play Single mode or all clips 
in Play All mode.

Playback Full Clips or Play within In/Out Points allows you to choose whether playback will play the entire 
clip, or will be limited to the set In/Out Points for that clip. If a clip has no specific In/Out Point set, then this 
option will play the entire clip.

The Play Queue is only visible when the A/B Timeline is shown, and allows you to quickly move to any point in 
any clip by clicking with the mouse. 
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13.4 Zoom, Viewport and Fit Options

Marker Overlay

Masked area
of image

Source 
Aperture

Viewport Options Fit Options Show/Hide Overlays
Re-centre image

Viewport Options allow you to specify how your viewport is fitted to the screen. Exactly which part of your 
source image this applies to depends on your Fit Options setting.

• Fill Screen sets your viewport to fill the screen with your image. This will fit either the x or y axis of your  
 image and crop the other, to ensure there is no blank space on your screen.
• Fit Screen ensures your entire image is displayed by either letterboxing (grey bars top and bottom of your  
 image) or pillarboxing (grey bars left and right of your image).
• Avail Space fits your viewport to the available space inside any open panels. For example if you have  
 chosen to show the Colour Controls, then your viewport will fit the remaining space above the Colour   
 Controls.      

Fit Options gives three fitting options, as well as allowing to enable zoom mode: 

• Fit Src Aperture fits only the specified Source Aperture of an image into your viewport.  
• Fit Src Apt + 5% fits only the specified Source Aperture of an image, plus and extra 5% lookaround, into  
 your viewport.
• Fit Src Canvas fits the entire recorded image into your viewport.
• 1x, 2x, and 4x enables Zoom mode and zooms to either 1x (1:1 pixels), 2x or 4x. Once you have enabled  
 one of these three modes, you can zoom in and out with the mouse scroll wheel or use keyboard   
       shortcuts listed below.  
• Re-centre sets the image centrally in the Viewport.

Keyboard shortcuts can be used for the Viewport and Fit Options:

 о F                Viewport Fill Screen 

 о A                Avail Space

 о =                1:1 Pixels (Zoom Mode)   

 о + (shift =)   zoom out

 о _ (shift -)    zoom in
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13.5 Overlays
By clicking the Overlays button in the top bar, you can toggle on/off overlays in your image, such as the basic 
clip information in the corner of your image, and QC regions you have set.

The above diagram shows Playhead A Marker Overlay and Playhead B Marker Overlay. These overlays show 
you the playhead that the image is loaded into (A or B), zoom level, the clip name, the current frame in the 
clip and the timecode that the playhead is currently parked on - for example; [A] [25%] 1.9_AA001 42/202 
20:39:03:03

Enabling or disabling Overlays will also show/hide any QC Region overlays.

13.6 Timeline
The Timeline view shows events for the currently playing clip:

• In/Out Points
• Notes
• QC Marks (see QC section later in this guide)
• Poster Frames

Playback Out Point

Show/Hide Timeline

Set Out PointPlayback In Point Set In PointPoster FrameNote Navigate Notes

13.6.1  Poster Frames, Notes, and In/Out Point
Set Poster Frame - The Poster Frame for each clip can be selected by moving to your chosen frame and then 
clicking Set Poster.

A Poster Frame can be used to most easily identify your clip. Once a Poster Frame is set, then this will become 
the Thumbnail in your Production Suite Library, and can also be exported as a Still image (See section 13.8). 

Notes - A Note is any frame in the clip you would like to easily navigate to. After setting a Note, use the Clips 
Panel in Notes mode to show a list of all the Notes that are set, and click to quickly move between them. 
These can also be exported as Still images (See section 13.8). 
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At any point in a clip you can set a Note by clicking Add Note. You have the option to name the Note in the 
box to right of Add Note, as well as move between Notes by clicking the arrow icons. The “X” icon to right of 
this will delete a Note.

In/Out Points - Click Set In and Set Out to create In/Out Points for each clip.

13.7 Clips
The Clips view allows you to navigate through your clips by clicking and scrubbing through the thumbnails.

Clip View Mode
Export Stills

Show/Hide Clip View

Playhead

• Toggle the Clip view on or off with the Clips icon at the top of the Review screen. The current position of the 
Playhead is indicated by the red line.
• You can choose to display the Clip view as Poster Frames for each clip, In/Out Points or Notes (See   
 Poster Frames, In/Out Points and Notes section 13.6.1) with the Clip View Mode control.
• Click anywhere on your Clip View timeline to move your Playhead to that frame. You can also click and  
 drag your mouse left and right to scrub through your clips.

13.8 Exporting Still Images
Still images for each clip can be exported, in 10-bit RGB dpx format, by clicking the cog icon and selecting to 
Export Stills. The Stills created will include any Looks that have been applied. The type of Still image saved 
depends on which Clip View Mode you have selected (i.e. Poster Frames, In/Out Points or Notes). These 
will be exported to a folder on your Desktop on Mac, or to a location specified in Vault Platform->Review-
>Configure->Stills Path on Vault S-Series/XL-Series.
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13.9 A/B Playheads
The default behaviour of Vault Review is to show a single clip in a single Viewport (Playhead Options set to A 
and Off). Vault Review also supports a dual Viewport functionality with A and B playheads.

Left
Viewport

Right
Viewport

Select A/B 
Playhead

Playhead Options Show/Hide A/B Playhead Timeline

A/B Timeline Playhead A Playhead B

13.9.1  A/B Timeline
You can add the A/B Playhead Timeline with the Show/Hide Playhead Timeline button. This allows you to 
independently move each of the two playheads (A and B) to any point in the timeline for your selected clips.  
To do this, click on the Select A/B Playhead options (A or B) and then select a point in the Timeline to move 
your Playhead to. 

Note: the position of Playhead A is indicated by a red line to the top of the A/B Timeline and that Playhead B 
is indicated by an orange line to the bottom.

13.9.2  Playhead Options
You can choose how you would like to display your Playheads with the Playhead Options dropdown menus in 
the top bar. 

• To only view one Playhead across the whole screen, set one of them to A or B, and the other to Off.
• To view A or B side-by-side in left and right viewports, set one to A and the other to B or vice-versa.
• You can also choose to display one of your Look Stills in either the left or right pane by selecting Still, and  
 then opening the Looks side panel and choosing the Look you would like to display. See section 4.10.5  
 for more information on the Look Stills side panel.

13.9.3  Comparing images, Zooming and Repositioning the A/B Viewports 
• By hovering your mouse in between the two images in the A/B Viewports, you will see a resize pointer   
 appear. By clicking and holding, and swiping your mouse left and right, you reveal more of less of each  
 image.
• When in 1x, 2x or 4x Zoom mode, you can hover your mouse over each Viewport and use your mouse scroll  
 wheel to zoom in and out of each image independently.
• Once zoomed out, you can click and hold on either image to reposition it anywhere on the screen.
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13.10 Colour
Display the colour controls by clicking on Colour in the top bar. This panel allows you to non-destructively 
add LUTs, and adjust CDL values using the colour wheels. The Colour Panel can be controlled by using the 
Tangent Element, Wave or Ripple panels, or simply with your mouse or trackpad.

13.10.1  LUTs
 
• LUTs to be used should be copied to /Library/Application Support/Codex/luts on Mac OS X, or /etc/codex/ 
 luts on Vault S-Series/XL-Series.
• Input/Output LUTs - Click the Edit Icon at the top of the In LUT selector box to the left of the Colour   
 Controls or on the Out LUT selector box, to the right of the Colour Controls to choose which LUT you  
 would like to use as an Input or Output LUT. Input/Output LUTs are global across all clips.
• Pre and Post LUTs - These can be chosen by clicking the Edit Icon in the Pre or Post boxes. You can also  
 disable or enable these LUTs. These LUTs affect only the selected clip.

Edit Icon
LGG/CDL/PL 
Mode Select 

Toggle Full/
Legal Output

Show/Hide Colour Controls

Colour OffsetMaster

Reset Colour Offset

Reset MasterReset all CDLBypass CDL

13.10.2  Colour Wheels 
The Colour Wheels are used to adjust the colour of the clip. Any changes will be saved as CDL metadata with 
that clip. CDL metadata can be exported as an ASC CDL xml file, which is compatible with other applications.  
  
There are three modes to select by clicking the Mode Select icon to the top-left of the Colour Wheels:

LGG = Lift Gamma Gain
CDL = Offset Power Slope
PL = Printer Lights

In LGG and CDL modes, the values are controlled with Colour Wheels. You can apply a Colour Offset using 
the dot inside the wheel, and control the magnitude of the effect with the grey semi-circular Master slider. 
There are reset controls underneath the Colour Wheels. The left-hand reset will zero the master control, and 
the right-hand reset will centre the colour offset. The left-most reset control is a master reset of all Colour Wheel 
controls in your selected mode.
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In PL mode, you can adjust Red, Green and Blue values with the up and down arrows. You can click the reset 
buttons to return each value to zero.

13.10.3  Saturation
Saturation can be adjusted with the Sat slider and reset with the reset button next to it.

13.10.4  Full or Legal Range Output
Click the Edit Icon on the right-most box in the Colour Controls (coloured blue) to Toggle between Full / 
Legal Outputs.

13.10.5  Look Stills Panel

Saved 
Look Still

Look Stills 
Panel

Add New 
Look

Export Looks 
Data

Show/Hide Looks Stills Panel
Show/Hide Live Look Panel

Delete Look

Edit Look

Apply Look to all Clips loaded

Apply Look to current Clip

The Look Stills panel allows you to save, apply, and export Looks. A saved Look is comprised of Pre LUT, 
CDL values, and Post LUT. (Note: the In and the Out LUTs are global settings in Vault Review, and so will not 
be saved in the Look file). 

• To save your colour changes as a Look, click the Add New Look button and you will see a new Saved  
 Look appear in the Looks Library Side Panel.
• To delete a Look, select it in the Look Stills panel, and click the Delete Look button. It will now disappear  
 from the Looks Library.
• Edit the name of a Look by selecting it in the Looks Library and then clicking the Edit Look button. Click       
 the Edit Look button again to exit edit mode.
• Double clicking on a Look will apply it to the current clip. This can also be done with the Apply Look to  
 Current Clip button.  
• By clicking the Apply Look to All Clips Loaded, you will see a dropdown menu allowing you to choose if  
 you would like to apply the selected Look to all clips currently loaded, or to end of timeline - this will apply  
 the Look to your current clip and then all further clips until end of the timeline. 
• You can use the search box at the top of the Looks Stills panel to search for a Look by name.
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• Export Look Data allows you to export your data in several ways: 
 о ALE - exports your CDL data in ALE format. You may select multiple Looks to be contained within a single ALE.

 о CCC - exports your CDL data in CCC format. You may select multiple Looks to be contained within a  single CCC file.

 о CDL - exports your CDL data as a CDL file. You may select multiple Looks which will be saved as    
 separate CDl files.

 о Live - exports all Looks into a Codex Live Look XML that can be loaded into Codex Live on another computer.

13.10.6  Live Looks Panel
Vault Review can work with Looks created in Codex Live. 

• Click the Show / Hide Live Looks Panel button to show any Live Looks available in the side panel.
• Live Looks will only be available if you have imported Live Look data, saved any Looks as Live Looks using  
 the Export Look Data option, or you have set up your computer to sync with Codex Live.  

13.10.7  Tangent Element Series
Colour can be adjusted in Vault Review with the Tangent Element series of controllers (Tk, Mf, Kb and Bt). 
Once connected the LCDs will indicate the parameters which can be adjusted with each of the controls. You 
can switch between LGG, CDL and PL modes, adjust Master and Offset, bypass LUTs, and use Transport 
controls.

Here are some additional controls not listed on the LCD’s:

Tangent Tk:

• Hold down A to toggle controls for Jog (to scrub through playback) and Saturation.
• Press B to cycle through LGG, CDL and PL modes.

Tangent Mf:

• Hold down A to use the wheel as a Jog control, and set In / Out points, as well as switch view to Red, Blue  
 or Green colour channels.
• Press B to cycle through control of each of the three colour wheels in LGG and CDL modes, or Red, Green,  
 Blue in PL mode.
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13.11  Audio Sync
Click the Audio Side Panel icon to open the Audio side panel. Here you can select from any Audio clips that 
are currently in the Library to sync with your Video clips. 

Selected 
audio clip

Show only 
matching 

audio clips

Audio 
channels 

for selected 
audio clip

Fit whole 
Audio Clip 
into Audio 
Timeline

Unused 
section of 
Audio Clip 
(Grey)

Synced section of audio clip (black) Audio Timecode Position Audio Sync Offset Audio Clip zoom
Apply Control

Audio Side Panel Show/Hide Show/Hide Audio Timeline

• Click the Audio icon to Show / Hide the Audio Timeline at the bottom of the screen. This will show the   
 waveform of any audio that is synced to your video clip. The red line will indicate the current position of  
 the audio clip playhead on the waveform. 
• The Audio Side Panel shows all audio clips currently linked to your Library. Any that match the timecode  
 of your currently selected video clip will have a percentage value next to the audio clip name, for example  
 CODEX_14 [20%]. The percentage value is the amount of the audio clip that matches with the video clip  
 timecode. In the above example, the audio recording started before the video clip, and ended after it.  
 If your audio clip started and stopped at exactly the same time as your video clip (i.e. start and stop   
 timecodes values match), you will see the audio clip name appended as [100%].
• The [R] and [S] icons next to some audio clips indicate a match of Roll or Scene with the current   
 video clip. 
• In the Audio Side Panel, select the audio clip that you wish to sync with your video clip. If there is a   
 timecode match (i.e. 20%), then the audio clip will be chosen and automatically synced with the video.
• The section of the audio clip that does not match the timecode of the video clip is shown with a grey   
 colour (Unused Section of Audio Clip), and the matched part of the audio clip is shown in black   
 (Synced Section of Audio Clip).
• At the bottom of the Audio Clip Library Side Panel, you will see the waveforms for the different channels  
 for your selected audio clip. In the example above, the audio clip has three channels. Click on each channel  
 to display that waveform in the Audio Timeline.
• Use the Fit icon to Fit the Whole Audio Clip Into Audio Timeline, or use the Audio Clip Zoom Contols  
 to zoom in and out of the waveform in the Audio Timeline.
• For manual Audio Sync, or if you wish to adjust the Audio Sync for any clips that have automatically synced  
 with timecode, Cmd-click (on Mac) or Ctrl-click (On Vault S/XL-Series) anywhere in the Audio Timeline to  
 move the red audio clip playhead to the desired position. 
• Use the Audio Sync Offset controls for finer control of the sync. The + and - symbols will advance or move  
 back in quarter frame increments.
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• The Audio Side Panel has further options for syncing your audio clips:
 о Auto Match - Selects best audio clip from the displayed list, considering timecode and roll / scene / take metatdata.

 о Auto Sync - Resets to audio offset of your current clip, so that audio and video timecode are in-sync.

 о Reset - Discards the audio changes made since last save.

13.12  Metadata View
Click Show/Hide Metadata to open up the Metadata View side-panel. (see below) You can select different 
views with the Choose Metadata View dropdown menu at the bottom of the side-panel.

13.13  Save Changes

Show/Hide save changes windowSave changes window

Choose Metadata View

Show/Hide Metadata

Any changes made in Vault Review will be stored in your Clip Changes window. These will not be committed 
to your clip until you click Save to save individual changes, Save All to globally save all changes, or until 
you exit Vault Review when all changes will be saved automatically. You can also use Cmd S at any time to 
globally save all changes.

Click Discard to discard individual changes or Discard All to discard all your changes before you exit.

13.14  QC Tool
The QC Tools allow you to mark events in your timeline per clip, frame or range of frames, and then save them 
as a QC Report.

• Click the QC button at the top of the screen to open the QC Toolbar:
• A QC mark can be for a single Frame, a Range of frames, or Global (all frames in the clip).  

 о Single Frame - Click Add In/Out to create a QC Mark on your current frame.

 о Range - Click Add In/Out to create a QC Mark. Move your playhead to the end frame of your range and   
 click Set QC Out.

 о Global - Click Add Global to create a QC Mark across your current clip.
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• A QC mark will default to being for a Region. A red box is shown, and you can click and drag to re-position  
 and resize the Region. Unclick the circle next to Region if the QC mark applies to the whole image.
• Click Predefined QC Mark Names dropdown to open a list of common issues, or click in the box to the left   
 to enter your own comment.
• After setting QC points on your clips, use the Reports task in Production Suite to create a QC report.

QC Toolbar On/Off

QC Region
Overlay

Clips View 
Mode set 

to QC

Add QC Mark QC Mark Selector QC Mark Range QC Region On/Off QC Mark Name Pre-defined QC Mark Names
Delete QC Mark QC Timeline



 PAGE  52CODEX USER GUIDE - CODEX PRODUCTION SUITE v.4.1.1 08.12.2016

13.15 Keyboard Shortcuts

Shortcut Action Comments

L Play forward Pressing during playing will increase the speed

K Pause

J Play backwards

K+L Play forward slow

K+J  Play backward slow

K+L tap Advance one frame

K+J tap Back one frame

right arrow Advance one frame

left arrow Back one frame

up arrow Next cut

down arrow Previous cut

shift+up arrow Next marker

shift+right arrow Previous marker

Home Go to beginning On MacBook Pro ‘fn'+Up Arrow

End Go to End On MacBook Pro 'fn'+Down Arrow

I Mark In

O Mark Out

Shift-I Go to In

Shift-O Go to Out 

+ (Shift =) Zoom In

_ (Shift -) Zoom Out

Cmd S Save Saves changes to all clips

H Hide workspace overlays/ui

F Viewport fullscreen

A Viewport available space

- (or Shift Z) Fit image to viewport

= 1:1 pixels

X Recentre image

M Show/hide marker overlays

F1 Show/hide timeline

F2 Show/hide qc panel

F3 Show/hide colour panel

F4 Show/hide metadata panel

F5 Show/hide viewport controls

F6 Show/hide clip palette 

F7 show/hide clip audio panels

F8 Show/hide look library

F9 Show/hide look stills

F12 Swap playheads
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Shortcut Action Comments

[ Move split screen left Moves the split screen on SDI only. Also one of the 
playheads need to be a still for SDI split screen to 
work.

] Move split screen right Moves the split screen on SDI only. Also one of the 
playheads need to be a still for SDI split screen to 
work.

Cmd 1 Colour panel reset all

Cmd 2 Colour panel edit cdl Toggles values panel when in CDL mode

Cmd 3 Colour panel bypass input LUT

Cmd 4 Colour panel bypass pre LUT

Cmd 5 Colour panel bypass CDL

Cmd 6 Colour panel bypass post LUT

Cmd 7 Colour panel bypass output LUT

Num Pad Clear Colour panel printer light red increase Alternatively:  1 if not numpad

Num Pad 7 Colour panel printer light red decrease Alternatively:  2 if not numpad

Num Pad = Colour panel printer light green increase Alternatively:  3 if not numpad

Num Pad 8 Colour panel printer light green decrease Alternatively:  4 if not numpad

Num Pad / Colour panel printer light blue increase Alternatively:  5 if not numpad

Num Pad 9 Colour panel printer light blue decrease Alternatively:  6 if not numpad

Num Pad * Colour panel printer light density increase Alternatively:  7 if not numpad

Num Pad - Colour panel printer light density decrease Alternatively:  8 if not numpad

Cmd + right arrow Slip Audio one step forward

Cmd + left arrow Slip Audio one step backward
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14. Codex Live
14.1 Introduction
Codex Live allows you to work directly with the camera feed over HD-SDI to create and preview looks that 
can be used to communicate the creative intent on-set, and as a starting point for dailies grading and 
post production. These looks can then be checked and refined in Vault Review, and used in Vault Platform 
when generating deliverables. Looks can also be exported as files such as ASC CDL xml for use with other 
applications.

Feature set includes:

• Integration with Fujifilm IS-mini (can be used with most digital cameras including the ARRI ALEXA XT / 65,  
 AMIRA, ALEXA Mini, Codex Action Cam, Canon C500/C300 Mark II, Panasonic VariCam 35, Sony F55/F5).
• Import and Export a range of look and LUT file formats.
• Grade live on-set via HD-SDI ‘Monitor Out’.
• Import Looks to Codex Production Suite, ‘Match Looks’ via timecode in Vault Platform, and apply looks in  
 Vault Review.
• Control and manage up to 32 Fujifilm IS-mini boxes, installed in-line with the HD-SDI outputs of the camera,  
 and supply on-set monitors with colour graded HD-SDI signals.
• Support for Tangent hardware controllers including the Element, Ripple and Wave panels.

14.2 Setup Requirements

14.2.1 Hardware
• Mac Pro running OS X 10.10, 10.11.6+, or 10.12 (recommended specification: Processor - 3.7GHz Quad  
 Core Intel Xeon E5, Memory - 32GB 1866MHz DDR3 ECC, Graphics - AMD FirePro D700 6144MB).
• MacBook Pro running OS X 10.10, 10.11.6+, or 10.12 (recommended specification: Processor - 2.8GHz Intel  
 Core i7, Memory - 16GB 1600MHz DDR3, Graphics - NVIDIA GeForce GT 750M 2048MB).
• IS-mini (Fujifilm)
• Camera (ARRI ALEXA XT / SXT / 65, AMIRA, ALEXA Mini, Codex Action Cam, Canon C500/C300 Mark II,  
 Panasonic VariCam 35, Sony F55/F5)
• Controller [optional] (Tangent Element, Ripple, or Wave)

14.2.2 Software
• Codex Live 
• A licence is required for Codex Live. To request a licence go to https://codexdigital.com/licence-request

14.3 Installation
1. Download and install the latest version of Codex Live (the software is installed to /Applications/Codex/Live)
2. If using a Tangent panel, download and install Tangent Hub (http://www.tangentwave.co.uk/support.asp) 
3. Connect the IS-mini to the Mac via USB
4. Connect the Colour control panel to the Mac via USB
5. Connect the IS-mini to the live camera feed (MON-OUT) via HD-SDI
6. Complete the required fields in the LUT Box Settings Panel (Only the Camera Index is mandatory):
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15. Operation
Launch Codex Live from /Applications/Codex.

The following functions and information are available in Codex Live:

Live Server 
Address

Vault Sync

Import/Export

User Account

Look History

Shut Down Settings Control Panel

Live Menu Blink LUT Box LUT Box Settings
Rescan Sync Status

Hide LUT Box
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Live Server Address - The address of the machine controlling the LUT box. Should be left at the default  
‘localhost’ setting.

Import->Wrench->ALE/CCC/CDL/LUT - Looks and LUTs from other applications can be imported.

Export->Wrench->ALE/CCC/CDL - Looks can be exported in these formats for use in other applications.

Settings->Project->Frame Rate - Set the Project frame rate from the connected camera here.

Settings->Project->Export Live Data - Export all looks from Codex Live in ‘Live Data’ format for import into 
Vault Platform or another system running Codex Live.

Settings->Project->Import Live Data - Import all exported Live Data from another system.

Settings->Project->Clear Live Data - Permanently deletes all Looks, LUT box settings and Look history.
 
Settings->Colour Control - Adjust the sensitivity and visibility of the colour controls.

Shut Down - Shut down the Codex Live application.

Look History - Codex Live automatically saves your changes 5 seconds after any adjustment to the Look has 
been made. The current look can be reverted to one of these saved settings at any time.

LUT Box Settings - Opens the LUT Box settings panel, further details are provided below.

Hide LUT Box - Removes highlighted LUT box from Live UI.

Rescan LUT Boxes - If connection is lost or new LUT boxes are added the rescan function will add them to 
the Live UI.

Blink LUT Box - Sets the output of the selected LUT box to a black image, allowing the user to visually identify 
which image is being adjusted.
 
Click on the LUT Box so it is highlighted in blue - the colour controls are now live and any changes you make 
will automatically be applied in the ‘Look History’ menu as Auto Commits.
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Current Look

Edit icon

Sort Looks
Lock Look

Duplicate Look

Toggle Looks
Rename
LUT Box
Camera Index
Camera ID

Set Input Range

Set Output Range

Set Input LUT

Set Output LUT

‘Bypass’ icon 
(Red = active)

Set pre LUT Lift/Offset Gamma/Power Gain/Slope Saturation Set Post LUT
Control Mode

Current LUT Box Timecode from Camera

Edit Icon - The pencil icon, shown in various places, allows editing of the settings.

Toggle Looks - Toggle Looks panel on and off. Open this panel to add looks and select / edit saved looks.

Current Look - The currently selected look is highlighted in blue.

Current LUT Box - A LUT box must be selected to make adjustments to the look. The currently selected LUT 
box is highlighted in blue. The camera index is displayed for quick identification.

Time Code from Camera - Running Time Code is a good indicator that the LUT Box is connected and 
receiving a signal from camera (However be aware that not all cameras output embedded Time Code over 
HD-SDI).

Rename LUT Box - Click this icon to rename the LUT box.

Camera Index - The Camera Index should always be specified. This is stored with looks and required to 
‘Match Look’ in Vault Platform.

Camera ID - Enter the 4 digit camera ID (or serial number) here.

Input Range - Specify whether the camera signal is Full or Legal range to ensure correct application of looks.

Output Range - Specify whether the output signal should be Full or Legal range to be correct for the attached 
monitor.

Input LUT - Click to select the Input LUT. This a Global setting applied to all connected LUT boxes.

Output LUT - Click to select the Output LUT. This a Global setting applied to all connected LUT boxes.

Set Pre LUT - Click to set the Pre LUT (for the selected Look only)
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Set Post LUT - Click to set the Post LUT (for the selected Look only). It is typical to select 3D LUTs, such as 
Log C to Rec.709, here or in the Output LUT slot, so that they are applied after CDL adjustment.

Control Mode - Choose from Lift Gamma Gain, Offset Power Slope, or Printer Lights mode, as detailed in 
the next section, Colour Controls.

Bypass Icon - The bypass icon can be used to toggle on and off any LUTs that have been applied at any 
stage, along with all CDL settings currently applied. Icon turns red when active.

Duplicate Look - Creates a copy of the current look.

Edit Looks - Click to rename any of the looks. Click again to leave edit mode and select a different look to 
adjust.

Lock Looks - Looks can be individually locked (padlock icon appears in Look graphic) preventing any further 
changes until it is unlocked.

Sort Looks - Sorts the Looks to be in alphabetical order, either from the top or bottom.

16. Colour Controls
Codex Live currently supports Tangent Element, Ripple and Wave control panels. Mapping and sensitivity can 
be adjusted via the Settings, as detailed earlier in this document.

Edit CDL

Bypass CDL

Reset All Magnitude Saturation 

Colour OffsetMode

Mode - The Mode button determines whether the control panel adjusts:

• LGG : Lift / Gamma / Gain / Saturation
• CDL : Offset / Power / Slope / Saturation
• PL : Printer Lights (Red / Green / Blue / Density) 

Element TK Hot Keys

A  In ‘L’ mode press and hold the A button to adjust saturation using the wheel on the right.
B  Press to cycle between L / S / P modes
•   Reset Magnitude
O  Reset Offset
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Much of Codex Live’s core functionality can be accessed via top menu drop-down windows, as detailed 
below.

Keyboard shortcuts are also listed here:

 
To map the keyboard shortcuts yourself, go to Misc > Edit Shortcuts and reassign the keys accordingly.
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17. Using ‘Match Look’ task in Vault Platform
Each look created in Codex Live is stored with a timecode range of when it was active.

If you are using Codex Live on the same machine as Vault Platform, there is no need to export the Live Data.  
If you are using separate machines for Codex Live and Vault Platform, first use the Export Live Data option in 
Codex Live, and then in Vault Platform go to: Preferences > Live and use ‘Look data: Import’

All looks created in Codex Live are now available in Vault Platform.

When clips are loaded into Vault Platform use the ‘Match Look’ task to apply looks to clips automatically based 
on timecode. 

Alternately, open the clips in Vault Review and use the Live Library side panel to manually choose a look to 
apply to a clip.
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Notes

Emergency out-of-hours support line +44 7985 467 665

    CODEX  60 POLAND STREET  LONDON  ENGLAND W1F 7NT  UK   TEL +44 203 7000 989  CODEX.ONLINE  INFO@CODEX.ONLINE
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